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Chapter 18
Assembly Modeling with the LEGO”

MINDSTORMS"® NXT Set — Autodesk” Inventor®

¢ Creating an Assembly Using Parts from
the LEGO® MINDSTORMS® NXT Set

¢ Understand and Perform Proper
Constraints in Assembly

¢ Adjust Components’ Orientations

¢ Create and Use Subassemblies in
Assemblies
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Introduction

The rapid development in computer hardware technology, during the past few decades,
has brought many changes in the practice of engineering in general. Many areas that were
traditionally identified as electrical engineering or mechanical engineering are now
multidisciplinary, integrating digital electronics, kinematics analysis, and computing
together. Additionally, the use of microcontrollers and embedded systems has become
inevitable in almost every engineering field. Given these developments, engineering
education has also witnessed significant changes, such as adapting to project-oriented
courses that emphasize real world applications, and the use of new educational tools such
as robot kits.

The use of robot kits provides many benefits, through assembling, building, and
following instructions, which help develop fine motor skills and hand-eye coordination.
Students are exposed to multiple subjects such as mechanics, electronics, and
programming. By working together to create robots that perform exciting challenges,
students also gain valuable critical thinking, problem-solving and team-building skills.
Students can also participate in several national/world robot competitions held annually,
which can provide a strong sense of accomplishment.

In this lesson, we will create a Basic Car assembly model using the LEGO®
MINDSTORMS® NXT Set. The modeling process can be used as part of a design
process, to simulate and confirm a design, prior to the actual construction of the project.
All of the required parts/subassemblies have been modeled in Autodesk Inventor, and can
be found on the publisher’s website:
www.SDCpublications.com/downloads/978-1-58503-873-2. Additional design ideas and
resource information are also available. Unzip all of the parts/subassemblies under a
folder in the Parametric-Modeling-Exercises project folder before starting on the
next section.

The Basic Car Assembly
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Modeling Strategy
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Starting Autodesk Inventor

1. Select the Autodesk Inventor option on the Start menu or select the
Autodesk Inventor icon on the desktop to start Autodesk Inventor. The
Autodesk Inventor main window will appear on the screen.

LCEEETEED 2. Select the New File icon with a single click of the

left-mouse-button in the Launch toolbar as shown.

Open Projects Open

Samples

3. Select the English units set and in the Template
list, select Standard(in).iam (Standard Inventor
Assembly Model template file).

Mew (Ctrl+ M)

‘. M ¥ Part — Create 2D and 3D objects
4. Click on the Create > (W Enoish |
button in the New File > Meld Design @ @
dialog box to accept the Sheet Standard
selected settings. (r,\:ft,';'t (et

¥ Assembly — Assemble 2D and 3D components

Maold |Standard | Weldment

Design | (in).fam | (ANSI).iam
in).iam &

B customize @» | 5. Inthe Ribbon toolbar, select the Tools tab.

Application | Docupgent @
Options Seﬂ:& =,']=Add-1ns

Document Settings

6. Select the Document Settings command as
shown.

Assemblyl Document Settings

7. Inthe Assemblyl Document Settings dialog :

box, click on the Units tab as shown. Standerd Unts | Sketch | Modeiing | il o

— Unit=s

8. Set the Length Units to millimeter as Length

shown. W
9. Click on the OK button to accept the Angle

selected settings. deares -

e The Standard Inventor Assembly Model template file contains predefined settings
including default 3D view orientation and default 2D drawing views setup. With
Autodesk Inventor, we are allowed to mix units within the same file.
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Creating a Subassembly

* We are now ready to assemble the components together. We will start by assembling
the NXT Motor, Bushings and Pegs into a Motor subassembly. A subassembly is
a unit assembled separately but designed to fit with other units in a manufactured
product. Subassemblies are commonly used to help manage complex designs and
when the same configurations are used multiple times in a design. Note that a
subassembly behaves just the same as a part within an assembly; i.e., a subassembly
possesses only six degrees of freedom, just like a regular part. Any moving parts
within a subassembly become fully locked inside the main assembly.

1. Switch to the Assembly panel, and select the Place
Component command by left-mouse-clicking the
icon.

Azzemble

Eﬂ;([f
PlagaiCeaat

-

Simplify

2. Select NXT Motor.iam (switch to the appropriate
folder if necessary) in the list window. Note this is a
subassembly containing five parts.

Place Component (P)

Com| Specifies one or more files

Place Component e |
Look in; | - Basic Car B2 e s NS
nt Center Files M T brick - Jackz.ipt HhMAT Light: Sensor. iam £S5
M=T brick. - screenl.ipk @NXT rmakor - Base.ipk @NX‘I
MAT brick - Screenz.ipt @NXT rmokar - Conneckor,ipk @Nbﬂ
M T Brick.iam EJRT mator - Drive.ipt ren
MAT light sensor - Base.ipk @NXT rmokar - Housing.ipk %Nbﬂ
MAT light sensor - Light Reduipt  [JMXT motor - Jack.ipt ren
MT light semsor - Light wihike.ipt ren
MET light sensor - Top.ipt M T*Sound sensor - Base.ipt @NX‘I
s - 2
File namme: INXT Mator.iam j
Files af type: IEomponent Filesz [.ipt; " iam) j
Project File: IF‘arametric-ModeIing-Exercises.i|:|j j Projects... |

Quick Launch iMates
2 {ﬁ {@ |82

3. Click on the Open button to retrieve the model.

Find ... | Options. .. | Qpen | Cancel |

4. Right-mouse-click once to bring up the option menu and
select Place Grounded at Origin to place the part.

5. Right-mouse-click once to bring up the option menu and
select OK to end the command.
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Placing the Next Component

» We will retrieve the Peg 71-module part as the next component of the assembly
model.

1. Inthe Assembly panel, select the Place Component
command by left-mouse-clicking the icon.

DGR Simplify

Sﬁ &'g Free Mo
Pladat | iCraate GC‘ Free Rotg

7| Place Component (F)

2. Select the Peg 1-module design in the list window.
Click on the Open button to retrieve the model.

Specifies one or more filg

3. Place two copies of the
Peg 1-module part
toward the left side of
the graphics window, as
shown in the figure.

4. Inside the graphics window, right-mouse-click once to bring up
the option menu and select OK to end the placement of the Peg
1-module part.

Model ~ 2]
?| {:I' Aszzembly View ~ i ]

e Inside the browser window, the retrieved parts are
listed in their corresponding order. The pin icon in
front of the NXT Motor assembly signifies the
component is grounded and all six degrees of freedom
are restricted. The number behind the name is used to
identify the number of copies of the same component
in the assembly model.

D Relationships
Eﬂ Representations
D Origin

[ NXT Motor: 1
@ Peqg 1-module: 1
@ Peqg 1-module:2
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Degrees of Freedom Display

Each component in an assembly has six degrees of freedom (DOF), or ways in
which rigid 3D bodies can move: movement along the X-, Y-, and Z-axes
(translational freedom), plus rotation around the X-, Y-, and Z-axes (rotational
freedom). Translational DOF's allow the part to move in the direction of the specified
vector. Rotational DOF's allow the part to turn about the specified axis.

|
Translational DOF  f—u—_, Rotational DOF

e Center of Gravity

» Select the Degrees of Freedom option in the
Object _ View tab to display the DOF of the unconstrained

|_B‘ Degrees of Freedom |

In parametric modeling, the degrees of freedom symbol shows the remaining degrees
of freedom (both translational and rotational) for the components of the active
assembly. Note that each component has its own degrees of freedom, even if the same
part is placed multiple times within the same assembly. The assembly constraints are
also applied independently to each component. The set of degrees of freedom
symbols, as shown in the figure above, signifies each copy of the Peg 1-module is
unconstrained and should be constrained independently.
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Apply the Assembly Constraints

3L Model I

‘:F I:EI;- Show
ConstEin

Relationships +

Inspect

& Hide All

2. Inthe Place Constraint dialog box,
confirm the constraint 7ype is set to
the Mate constraint.

1. Inthe Assembly panel, select the Constrain
command by left-mouse-clicking once on the icon.

Place Constraint

(=]

Assembly | Motion | Transitional | Constraint set |

Type Selections
FIEENEIEN
Solution

| e

£ &

Offset:
0.000 mm

Fifui=CRElE

|

| ok || cancel || apply

5. Click on the back ring face of
the Peg 1-Module part as
the second part selection to
apply the constraint.

6. Click on the Apply button to
accept the selection and apply
the Mate constraint.

3. Select the ring surface of the
NXT Motor Drive as the
first item for the Mate
Alignment command.

4. On your own, use the View-
Cube and rotate the display
to view the opposite side of
the Peg 1-Module parts.
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Place Constraint 3

Assembly | Motion | Transitional | Constraint Set |

Type Selections 7 In the Pl C dial
. In the Place Constraint dialog
H[ 5 " ol " (] "ﬂH M B 2 (i box, confirm the constraint Type is
Offset Solution set to the Mate constraint.

¥ 6o O EF

[ o J[Lcme J[ sy | [>]

8. Select the right
cylindrical surface of
the base component,
the chassis rail, as the
first item for the Mate
Alignment command.

9. Click on one of the
outside cylindrical
surfaces of the Peg
1-Module part as
the second item to
apply the constraint.

10. Click on the Apply
button to accept the
selection and apply
the Mate constraint.
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11. On your own, repeat the above steps and constrain the other Peg 1-Module as
shown.

Note there is still one rotational
degree of freedom available.

12. In the Assembly panel, select the Place Component

Assemble I command by left-mouse-clicking the icon.

Cf '*'G Free Mo
‘%, | %7 Free Rot: 13. Select the Beam 3-Module design in the list window.
- (easta Click on the Open button to retrieve the model.

-

Place Component (P)

Specifies one or more filg

14. Place one copy of the
Beam 3-Module toward
the left side of the
graphics window, as
shown in the figure.

15. Inside the graphics
window, right-mouse-
click once to bring up the
option menu and select
Done to end the
command.
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L Model

\:F

Joint CunstEin

Relaticnships -

Inspect

I:F-,; Show
=)

& Hide All

Type
17. In the Place Constraint dialog E@@ E &

box, confirm the constraint 7ype

is set to the Mate constraint. 0,000 mm . I E I @‘

19. Click on the front
surface of the
Beam 3-Module
part as the second
part selection to
apply the constraint.

20. Click on the Apply
button to accept the
selection and apply
the Mate constraint.

16. In the Assembly panel, select the Constrain
command by left-mouse-clicking once on the icon.

Place Constraint £3

Assembly | Motion | Transitional | Constraint Set |

Selections

Offset: Solution

v &o' [CEF

| ok || cancel

J[ ooy ] [22)

18. Select the front vertical
surface of the base component,
the chassis rail, as the first item
for the Mate Alignment
command.
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21. Select the right inside
cylindrical surface of the Beam
3-Module component, the chassis
rail, as the first item for the Mate
Alignment command.

22. Click on the outside
cylindrical surface of the
right Peg 1-Module part as
the second item to apply the
constraint.

23. Click on the Apply button
to accept the selection and
apply the Mate constraint.

24. On your own, align the
center axis of the left feature
to the center axis of the
other Peg 1-Module part as
shown.
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Assemble the Next Components

s Next, we will assemble copies of the Bushings and Axle parts.

1. Inthe Assembly panel, select the Place Component
command by left-mouse-clicking the icon.

Place Component e |
i~ +
reste Look in: I@ Basic Car j Q [’ % -
PlaCE' Cﬂm pCI-nEHt I:Fl:] Eeam 11-madule.ipt Fra
e =7 Beam 13-module.ipt Bushigg.ipt &Fra
S ECIﬂ £5 ONE or more ﬂl i Beam 15-madule.ipt @Bushing-N.ipt &Full
Eeam Angular-2x4.ipt @Cross Elock 2-madule.ipt &Hae
Beam Angular-3x5.ipt @Cross EBlock Z:x1 module.ipk @Hut
Eieam Angular-4x6 .ipk @Cross EBlock 3-madule.ipt @Hul:
Bieam double bent-7x1x2.ipt @DC Geathead Motar.ipt @Hul:
2. Select the Bushing fxle Extender ipt %Frame-Center‘iam &Mot
Bushing half ‘ 1 i
deSigl’l ln the hSt File: narne: IBushing half.ipt j
WindOW. Click on Files of type: IComponent Files [*ipt; *iam) j
the open button Project Filz: IParametric-MndeIing-Exarcises.ipj j Prajects. .. |
tO I'etI'iCVe the Guick Launch iMates
ae
mOdel’ @I ’7 . | ’7 ®© | =0 Find ... optians. .. | Cpen I Cancel |

3. Place a copy of the Bushing
half toward the left side of
the graphics window, as
shown in the figure.

4. Inside the graphics window,
right-mouse-click once to
bring up the option menu
and select Done to end the
placement of the part.

Liesign 3L Model

Inspect

:F!&- Show

5. Inthe Assembly panel, select the Constrain @L.D \:F
command by left-mouse-clicking once on the

. Joint |Constgain
1COon. b

Relationships =

&, Hide Al ‘
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6. On your own, apply two Mate constraints to fully assemble the part as shown.
Note the part still has one degree of freedom available; it can still rotate about the
center axis.

. In the Assembly panel, sclect the Place Component

Assemble QT Taly C . .
= command by left-mouse-clicking the icon.

g g Free Mo

% Free Rotd) 8.  On your own, place copies of the Bushing.ipt and the
Axle-8.ipt parts toward the right side of the assembly as
shown.

Croate |

Place Component (P)

Specifies one or more filg
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Assembling Bushing and Axle

Design 30 Model

“o| g

Constrain

Inspect

':F!En' Show

& Hide All |

‘ Relatl Constrain (C)

2. On your own, apply a Mate
constraint to align the center axes
of the two parts as shown.

3. Also apply a mate constraint to
align two of the flat surfaces on
the two parts.

1. Inthe Assembly panel, select the Constrain
command by left-mouse-clicking once on the icon.

Place Constraint

Assembly | Motion | Transitional | Constraint et |

Type Selections

IR E]LIPN oy
Offset: Solution

0.000in 3 %
&o’ [CETF \—/

In the Place Constraint dialog box,
set the constraint Type to the
Flush constraint.

On your own, select the two end
surfaces to align the Axle to the
Bushing as shown.
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Place Constraint @

Assembly | Motion | Transitional | Constraint Set |

Type Selections
EIEENRIPN W
Offset: Solution

¥ &o' EET
) oo ) B2

6. Inthe Place Constraint dialog box, set
the constraint 7ype to the Mate
constraint.

\ ook || cancel

7. Select the flat face of the Bushing
half part as shown.

8. Select the corresponding flat surface
of the Axle-8 part as shown.

9. Click on the Apply button to accept
the selections and apply the Mate
constraint
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10. On your own, repeat the above steps and constrain the vertical face of the
Bushing to the left side of the Motor-Drive part as shown.

Croato

':"D Free Rotd

"| Place Component (P)

13. Place four copies
of the part around
the current
assembly model.

Specifies one or more filg

11. In the Assembly panel, select the Place Component
command by left-mouse-clicking the icon.

12. Select the Peg 1-Module design in the list window.
Click on the Open button to retrieve the model.

Place Component

2|

Lok in: I@ Basic Car

e mE

Center Files MAT Sound Sensor.iam %NXT Ultrasonic Sensor.iam @Tire
MAT touch sensor - Base.ipt @Tire
MET bouch sensor - Mose.ipt Peg 2-molsgle Double.ipt %Wh
MET kouch sensor -Top.ipt @Peg S-module with bushing.ipt %Wh
M=T Touch Sensor.iam Peg 3-module.ipt
MET ultrasonic sensor - Base.ipt @Peg half-axle.ipt
MET wltrasonic sensor - Eye.ipt @Peg.ipt
MAT ultrasonic sensor - Top.ipk %swivel-Rear.iam
L e M
File name: IPeg 1-module.ipt j
Files of type: IEomponent Filez [*.ipt; *.iam] j
Project File: IParametric-ModeIing-Exercises.ipj j Projects... |
Cuick Launch iMates
| | ae
@l ’7 . I ) ’7 ® | -0 Find ... COptions... | Open | Cancel |

14. Inside the graphics window, right-mouse-click once to bring up
the option menu and select OK to end the placement of the part.
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15. On your own, apply the Mate constraints to assemble the four copies of the Peg
1-Module part as shown.

5p

" Place Com ponent (P)

ecifies one or more filg

. In the Assembly panel, sclect the Place Component

command by left-mouse-clicking the icon.

. On your own, place one copy of the Peg 2-module

Double part, Cross Block 2x1 module part and Peg
half-axle part into the assembly.
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3D Model

‘:F

loint |Constrain

Dresign

Inspect

e Show 3. Inthe Position panel, select the Constrain
command by left-mouse-clicking the icon. On your

own, assemble the three parts as shown in the figure.

& Hide All

Relall Constrain (C)

=[E]e e
h‘-.ir-plif-- 4. On your own, Save the completed model as a

. subassembly, using the name: Motor-Right.iam.
[ 3 Cf 3 Free Move

C‘G Free Rotate

21X

Save in:l@ Basic Car j Q |} 2 [
[arne =~ | Sizel Type =
I Oldversions File Folder
E'_‘]P.rm.iam TAKE  Autodesk Inventor ...
EhBase Frarne.iam 120KE  Adtodesk Inventar ...
EhFrame—Center.iam 76KE  Autodesk Inventor ...
EhFrame—Front.iam 92KE Autodesk Inventor ... |
E Frarme-Rear. iam S3KE  Autodesk Inventar ...
E!‘]Fulll Jdam 118KE  Autodesk Inventar ...
EhHead.iam 87 KB  Autodesk Inventor ...
EhMotor-LeFt.iam 91 KE  Autodesk Inventor ...
EhMotor-Right.iam 92KE Autodesk Inventar ...
«| | »
File name: IMotor-Hight.iam j
Save az type: I.&utodesk Imventor Azzemblies [.iam) j

Ell Preyvigw, | Cpkions. .. | Saye Cancel
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Starting the Main Assembly

= H<S &

[ 4

1. Select the New File icon with a single click of the
Mew (Ctrl+N) left-mouse-button in the Quick Access Toolbar as

[Q_"i Move shown.

2. Select the English units set and in the Template list; select Standard(in).iam
(Standard Inventor Assembly Model template file).

4 |1 Templates
> | . English |

=0 Metnc
> 1 Mold Design @ @
Sheet Standard

Metal  (in).ipt
{in).ipt

¥ Part —Create 2D and 3D objects

¥ Assembly — Assemble 2D and 30 companents
Mold |Standard Weldment

Design | (in)yam | (ANSI)iam
in).iam ES

3. Click on the OK button in the New File dialog box to accept the selected settings.

4. 1In the Ribbon toolbar, select the Tools tab.

&4 Customize @B

Application | Docupent @
COptions Seﬂ:% Eﬂ:Md-Ir,g

5. Select the Document Settings command as

shown.
Document Settings
Assembly? Document Settings

6. Inthe Assembly2 Document Settings dialog Standard  Units |5kﬂt.;|-. | Madelin

box, click on the Units tab as shown. it

- unics

7. Set the Length Units to centimeter as shown. Length
8. Click on the OK button to accept the selected N g

settings. :

degree hd

e The Standard Inventor Assembly Model template file contains predefined settings
including default 3D view orientation and default 2D drawing views setup. With
Autodesk Inventor, we are allowed to mix different units within the same file.
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9. In the Assembly panel, select the Place Component
command by left-mouse-clicking once on the icon.

Craate

*| Place Component (P) 10. Select the Beam 13-module part in the list window.
Click on the Open button to retrieve the model.

Specifies one or more filg

Place Component

2
Look in: I@ Basic Car

[ {)Eeam 11-module.ipt @Bushing half ipt &Fra
'_‘E:Eam 13-odule.ipt @Bushing.ipt &Fra
‘JEeam 15- dule.ipt @Bushing-N.\pt %FUII
.'i Bieam Angular-2x4.ipt @Cross Elock 2-module.ipt He:
( JEcam Angular-3:5.ipt @Cross Elock 2:1 module.ipt @Hut
[ Eieam angular-4x6 ipt @Crnss Elock 3-module. ipt @Hut
([J5eam double bent-7x1:2.ipk @DC Gearhead Motor,ipt @Hut
.'I Bushing Axle Extender.ipt &Frame-Center.\am Mot

] [l
File: name: IBeam 13-madule.ipt j
Files of type IComponent Files [*.ipt; ".iarn] j

Project Fils: IParamatric-MndEIing-Exercwses.ipi j Projects... |
Quick Launch iMates

ae

3) h E| bl»_ﬂ.

Fird ... | COptions... | Cipen | Cancel |

11. In the graphics area, place two copies of the part, with the first copy to the left
side, as shown in the figure.

12. Inside the graphics window, right-mouse-click once to bring up the option menu
and select Done to end the placement of the Beam 13-module parts.
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13. In the Assembly panel, select the Place Component
command by left-mouse-clicking once on the icon.

14. Select the Frame-Front assembly in the list window.
Click on the Open button to retrieve the model.

Place Component (P)

Specifies one or more filg

Place Component 2x|
Loak in: I I25 Basic Car j Q¥ -
Center Files @Bushing half ipt
Bushing.ipt gadear,

@Bushlng-N.lpt EhFuIIl.lam @le
@Cross Block 2-module.ipt Eh Head.iam @Nm
() Crass Black 2x1 module.ipt )Hub S6x 26.0pt e
@Cross Elock 3-module.ipt @Hub - cenker,ipk @NX'I
@DC Gearhead Mator,ipt @Hub - small.ipk @Nm
3 Frame-Center iam B matar-Left.iam [
Kl 1 Fl
File name: IFrame-Front.iam j

Files of type: IEomponent Files [".ipt; ".iamm) j

Project File: IParametr\c-ModeIing-Exercwses.ipj j Projects... |

Quick Launch iMates
2 {ﬁ { ®© |82

15. In the graphics area, place a copy of the Frame-Front subassembly to the right
side of the other pieces.

Find ... | Options... | Cpen | Cancel |
Y/

16. On your own, repeat the above steps and place a copy of the Frame-Center
subassembly to the left side of the screen.
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Assemble the Frame and Motors

Design 30 Model

“o|d

Joint |Constrain

T

Inspect

:F!&- Show

1. Inthe Assembly panel, select the Constrain
command by left-mouse-clicking once on the icon.

Place Constraint 3

I Hide Al |

‘ Relatl Constrain (C) Assembly | Motion | Transitional | Constraint Set |

Selections

Type
EEER 1N oL
2. Inthe Place Constraint dialog box, | ©f=t soluton

switch to the Mate constraint. 0.000 mm » % ﬁ

&o [CAdF
oK Cancel Apply

3. Select the inside face of the inner
vertical face of the left Beam 13-
module as shown.

4. Select the circular face
of the Peg part of the
Frame-Front
assembly as the 2™ item
for the Constrain
command.

5. Click on the Apply
button to accept the
selection and apply the
Mate constraint.
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7. Select the circular face of the

6. Select the first hole feature, on the
inside cylindrical surface, of the left
Beam 13-module as shown.

Peg part of the Frame-Front
assembly as the 2™ item for
the Constrain command.

Click on the Apply button to
accept the selection and apply L
the Mate constraint. :

|

On your own, repeat the above steps and assembly the Frame-Center
subassembly and the other Beam 13-module as shown.

e Note the two subassemblies can still
pivot about the center axes connected
to the Beam 13-module parts.
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Assemble the Motor Assemblies

Assernble REIRIINE 1. In the Assembly panel, select the Place Component
Ei} 5 Free Mo command by left-mouse-clicking the icon.

':b Free Riot3

Croata

"| Place Component (P) . Select the Motor-Left assembly in the list window.
Specifies one or more fild Click on the Open button to retrieve the model.

Place Component e |
Laok ir: I@ B asic Car j QR
rk Center Files Bushing half ipt B4 Frame-Frant.iam H ot
Bushing.ipt %Frame-Rear.iam @NX"I
Bushing-H.ipt BhFullt iam rn
Cross Block 2-module.ipt E]Head.iam @NX‘I
Cross Block 231 madule.ipt £ Hub S6x 26.ipt rn
Cross Block 3-module. ipk @Hub - cenker.ipt @NX‘I
DiC Gearhead Mokor,ipt @Hub - small.ipk @NX‘I
Frame-Center iarm @NX‘I
d - I
File name: IMotor-Left.iam j
Files of twpe: IEomponent Files [.ipt; " iam) j
Project File: IParametric-ModeIing—Exercises.i|:|j j Projects. .. |
Guick Launch iMates
e
@l ’V ' l ) | ’V @ | L 5] Find ... | Optians. .. | Jpen | Cancel |

4. Inside the graphics window, right-mouse-click once to bring up the option menu
and select Done to end the Place Component command.
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ool Simplify  Design

i & 1 5. Select the Free Rotate command by left-mouse-
j” {j FreeMove | [ I O clicking once on the icon.

|
Joint Consf
|

Free Rotate (G)

reate

ht -

6. On your own, use the left-mouse-button and rotate the Mofor to the orientation as
shown.

Design

3D Model  Inspect

ﬂhD I:F :F!T-l- Show

loint |Constrain

7. 1Inthe Assembly panel, select the Constrain
command by left-mouse-clicking once on the icon.

I Hide Al |

‘ Relatl Constrain (C)

8. Select the last hole feature,
on the inside cylindrical
surface, of the left Beam
13-module as shown.
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9. Select the circular face of the back Peg
part of the Motor-Left assembly as the
27 jtem for the Constrain command.

10. Click on the Apply button to accept the
selection and apply the Mate
constraint.

.

12. Also apply a Mate constraint to align the inside surface of the Motor
subassembly as shown.
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13. Adjust the positions of the Frame-Center and Frame-Front subassemblies by
drag-and-drop with the left-mouse-button.

3D Model
':F!&' Show

Dresign Inspect

14. In the Assembly panel, select the Constrain
command by left-mouse-clicking once on the icon.

loint |Constrain

& Hide All |

| Relatl Constrain (C)

15. Select the last hole feature, on the
inside cylindrical surface, of the
Motor-Base part as shown.

16. Select the curved surface of the Axle
part of the Frame-Front assembly as
the 2" item for the Constrain
command.

17. Click on the Apply button to accept
the selection and apply the Mate
constraint.
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18. In the Assembly panel, select the Place Component
command by left-mouse-clicking the icon.

Assemble TG

Cf ‘*’g Free Mo

P % FreeRotdl 19. Select the Beam Angular-2x4 part in the list window.
" Place Component (F) Click on the Open button to retrieve the model.

Specifies one or more filf) ([N RN G 20|

Laok in: I@ Blasic Car j Q = E-

Center Files ﬂaxle-lﬂ.ipt @Beam 11-module.ipt @Bus
9 Base Frame. iam @Beam 13-module.ipt @Bus
HBasic-Car.jam @Beam 15-module.ipt @Bus
@Beam 3-Cenker.ipt EBieam Angular-Z:x4.ipt Zro
@Beam S-module.ipt il Beamn Anguksi-3x5.ipt @Cro

Bearn S-module.ipt @Beam Angular-4:x6 ipk @Cro
@Beam 7-module.ipt @Beam double bent-7x1x2.ipt @DC
@Beam S-module.ipt @Bushing fixle Extender.ipt %Fra
Per ||
File name: IBeam Angular-2xd.ipt j
Files of type: IEomponent Files [".ipt; ".iam] j

Project: File: IParametric-ModeIing-Exercises.ipj j Projects... |

Quick Launich iMates
] {ﬁ {@ |82

20. Place one copy of the part toward the left side of the graphics window.

Find ... | Options. ., | Cpen | Cancel |

21. On your own, assemble the Beam Angular part to lock the Frame-Center and
Frame-Front in place as shown.
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Adding the Motor-Right Subassembly to the Main Assembly

In the Assembly panel, select the Place Component
Assemble [T command by left-mouse-clicking the icon.

Ci} o FreeMofl 5 Select the Motor-Right assembly in the list window.

.| %o Free Rot3 Click on the Open button to retrieve the model.
raata
- Place Component 7| %
Place Component (P) x|
Specifies one or more filg Look in: | £ Basic Car Hod = m
= Motor-Right jam AT brick - Jackz.ipt Ty
(NAT brick asel Jipt {IMT brick - screent.ipt [
(MAT brick - Base.ipt [IMT brick - Screenz.ipt e
[ {NAT brick - Baseo.ipt BT Brick.iam [
(JMAT brick - Buttonl.ipt (MT light sensar - Base.ipt e
(MAT brick - Buttonz.ipt (MT light sensar - Light Red.ipt  [[JMX1
il =T brick - Butkon3.ipt @NXT light sensor - Light White.ipt %NX'I
{JMT brick - Jackl.ipt (AT light sensar - Tap.ipt ux
I i
File name: IMotor-Hight.iam j
Files of type: IEomponent Files [*ipt; “.iam) j
Project File: IParametric-ModeIing-Exercises.ipj j Projects... |
Guick Launch iMates
| ae
@I ’7 . I ) ’7 ® | -0 Find ... | Options. .. | Cpen | Cancel |
VA

3. Place one copy of the assembly toward the right side of the graphics window.

4. On your own, repeat the same procedure to assemble the Motor-Right assembly
and a copy of the Beam Angular-2x4 part as shown.
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Assemble the Rear Swivel Assembly and Wheels

In the Assembly panel, select the Place Component
command by left-mouse-clicking the icon.

Assemble EEETGTONN

Ci? +3 Free Mo
G Free Rota] 2+ Select the Beam 11-module part in the list window.
Click on the Open button to retrieve the model.

Place Component 1 ed 3

Lok in: I@ Basic Car j QT = mE-

Croate

Place Component (P)

Specifies one or more filg

ﬂaxle-lﬂ‘ipt Eeam 11-module.ipt
58558 Frame.iarm (Beam 1 k odule.ipt @Bus
%Baslc-car.lam @Baam 15-rodule.ipt @Bus
@Baam 3-Center.ipt @Baam Angular-2:4.ipt @Cro
3 * Place one Copy Of the @Baem S-module.ipt @Baam Angular-3x5.ipk @Cro
part toward the rlght @Baem S-module.ipt @Baam Angular-4:6 ik @Cru
. . @Baam F-module.ipt @Baam double bert-7x1:2.ipk @DC
Slde Of the graphlcs @Baam 9-module.ipt @Bushmg Axle Extender.ipt &Fra
window. i — i
File name: IBEam 11-module ipt j
Files of type: IEomponenl Files [".ipt; ".iam] j
Project File: IPararnetric-MDdeIing-Exercises.ip] j Projects...

HLTI0E

Find ... Cptions. .. | Cpen | Cancel |

v

4. On your own, assemble the part as shown.
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In the Assembly panel, select the Place Component

Assernble TG0 C . .
) command by left-mouse-clicking the icon.

'*'g Free Mo

%~ Free Rotg 6. Select the Frame-Rear assembly in the list window.
Click on the Open button to retrieve the model.

Croato

”| Place Component (F)

Place Component

Specifies one or more filg

Lok in: I 55 Basic Car j (€ N5 il
@Bushing half ipt: %Frame-Front.iam %Mot
{Eushing.ipt D
{{)Bushing-H.ipt BhFu e
@Cross Elock 2-module.ipt &Head.iam @NX'I
(7] Crass Black 2x1 module.ipt () Hub St 26.ipt e
@Cross Block 3-module.ipt @Hub - center.ipt @NX'I
@DC Gearhead Mator,ipt @Hub - small.ipt @Nm
%Frame{enter.iam %Motor-LeFt.iam @NX'I
Kl —| i
File name: IFrame-Hear.iam j
Filez of type: IEomponent Files [*.ipt: *.iam) j
Project File: IParametric-ModeIing-Exercises.ipj j Projects... |
Cuick Launch iMates
| Be
@l ’7 . I ) ’7 ® | 0 Find ... | Options. .. | Qpen | Cancel |

8. Inside the graphics window, right-mouse-click once to bring up the option menu
and select Done to end the Place Component command.
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SnlLAEE  Simplify  Design 3D
1 9. Select the Rotate Component command by left-

- Free M i e i
j" i) rree Viove mouse-clicking once on the icon.

L
-
| ‘ot “en=8 0. On your own, use the left-mouse-button and rotate the

subassembly to the orientation as shown.

reate

Free Rotate ()

nt «

11. On your own, apply the necessary constraints to align the subassembly to the two
Peg 2-module Double parts as shown.
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Croats

7| Place Component (F)

Specifies one or more filg

12. In the Assembly panel, select the Place Component
command by left-mouse-clicking the icon.

13. Select the Swivel-Rear assembly in the list window.
Click on the Open button to retrieve the model.

Place Component

2=

Lok i I@ Basic Car j Q L’ [® -
05 10T Ultrasonic Sensor.iam ) ire 56 26 vR.ipt
(Peq 1-module.ipt @Tire small.ipk
{{JPeg 2-module Double.ipt %Wheel 56 % 26 YR.iam
({)Peq 3-madule with bushing.ipt %Wheel-small.iam
il Peq 3-module.ipt
il Peq half-axle.ipt
-

S

File name:

IswiveI-H ear.iam

Filez of type: IEomponent Files [.ipt; *.iam]

[
=

Project File: IParametric-ModeIing-Exercises.ipj

j Projects. .. |

o |

Guick Launch

LT

iMates

©| 8

Find ... | Options. .. |

Open | Cancel |

A

14. Place one copy of the Swivel-Rear assembly next to the assembly.

15. On your own, rotate the assembly to the orientation shown.
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30 Model Ti

EF I:E,;- Show

loint |Constrain

Design

Inspect

16. In the Assembly panel, select the Constrain
command by left-mouse-clicking once on the icon.

oy Hide All |

Relat] Constrain (C)

17. Select the center hole feature, on
the inside cylindrical surface, of
the Peg 5-Module part as shown.

18. Select the curved surface of the Axle part
of the Rear-Swivel assembly as the 2™
item for the Constrain command.

19. Click on the Apply button to accept the
selection and apply the Mate constraint.

20. Select the bottom surface of the
Beam 3-Center part as shown.

21. Select the top surface of the Bushing
part of the Rear-Swivel assembly as
the 2" item for the Constrain
command.

22. Click on the Apply button to accept the
selection and apply the Mate
constraint.
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23. On your own, assemble a copy of the Bushing to the Axle of the Rear-Swivel
assembly as shown.

24. On your own, assemble a Wheel-Small assembly and two copies of the Wheel
56x26 VR assembly as shown.
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Assemble the NXT Micro-controller

n- B e

Assemnble TG0

ﬁ% Ci} &'g Free Mo
Plada® | Craate Cb Free Rotd

7| Place Com ponent (P)

Com Specifies one or more fils

3. Place one copy of
the assembly toward
the right side of the
graphics window.

In the Assembly panel, select the Place Component
command by left-mouse-clicking the icon.

Select the NXT-Brick assembly in the list window.
Click on the Open button to retrieve the model.

Place Component 2l

Look in: I IC7 Basic Car j e ? 9 [
Mator-Right iam [T brick - Jackz.ipt Bren
KT brick - Base1.ipt [DIMAT brick. - screent.ipt nx
MAT brick - Base.ipt @NXT brick - Screen2. ipt @NX'I
WA birick - Basea.ipt e
T brick - Buttand.ipt MT it sensor - Base.ipt [y
MT brick - Buttanz.ipt @NXT light sensor - Light Red.ipt @NM
KT brick - Butkonid,int [EDIMAT licht sensor - Light White ipt Bgre
MAT brick - Jackl.ipt @NXT light sensor - Top.ipt @NX'I

g 1 ]|

File name: —[NXT Biick.iam =l
Files of type: IEomponent Files [".ipt; iam] j
Project File: IParametric-Modeling-Exercises.ipj j Projects... |

Find ... | Options. .. | Open | Cancel |

Quick Launch iMates
3 [i { ® |5

4. On your own, also place two copies of Peg 1-Module and Beam 5-Module
into the assembly as shown.
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Design

30 Model T

Inspect

ey Show 5. In the Assembly panel, select the Constrain

command by left-mouse-clicking once on the icon.

=

Constrain

& Hide All |

Relat] Constrain (C)

6.

We will first align the
bottom of the NXT-Brick
to the Frame-Front
assembly. Select the
outside cylindrical surface
of the right Peg 1-Module
part of the Frame-Front
assembly as shown.

7. Select the center axis of the first hole
feature on the bottom right of the NXT-
Brick assembly as shown.

8. Click on the Apply button to accept the
selection and apply the Mate
constraint.
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9. Select the outside cylindrical surface of
the left Peg 1-Module part of the
Frame-Front assembly as shown.

10. Select the center axis of the first hole
feature on the bottom left of the
NXT-Brick assembly as shown.

11. Click on the Apply button to accept
the selection and apply the Mate
constraint.

12. On your own, assemble the two sets of Peg 1-Module and Beam 5-Module
parts as shown.




18-40 Tools for Design Using AutoCAD and Autodesk Inventor

Assemble the Sensors

n- B e

Assemnble TG0

In the Assembly panel, select the Place Component
command by left-mouse-clicking the icon.

o) Ci} '*'g Free Mo
lﬁ, G Free Rotd] 2 Select the Arm assembly in the list window. Click on
Plagas L easta the Open button to retrieve the model.

7| Place Com ponent (P)

Place Component ﬂﬂ

Com Specifies one or more fils

Loak in: I@ Basic Car j Q A

Oldversions @axle-lﬂ.ipt @Bee
Base Frame.iam @Bee
gxleldnotched.ipt %Basic-Car.iam @Bee

3. Place one copy of

axle-3.ipt @Beam 3-Center.ipt @Bee
the assembl}.l axle-4.ipk @Beam 3-module.ipt @Bee
toward the I‘lght Fxle-5.pk @Beam S-module.ipt @Bee
. . axle-6.ipk @Beam F-module.ipk @Bee
Slde Of the graphICS axle-G.ipt @Beam S-midule.ipk @Bus
window. 0
File name: IArm.iam j
Filez of type: I Component Files [*.ipt; *.iam) j

Project File: IParametric-Modeling-Exercises.ip] j Projects. ..
Cuick Launch iMates

(2] 2]

o [h L [@M

4. On your own, also place a copy of the Head assembly into the current assembly
as shown.

Find ... | Options... | Cpen | Cancel |

v
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30 Model

=n

loint |Constrain

Design T/

Inspect

I:E&- Show

5. In the Assembly panel, select the Constrain
command by left-mouse-clicking once on the icon.

& Hide All

Relat] Constrain (C)

6. Align the center axes of the upper
Peg on the Arm assembly to the
corresponding hole feature on the
NXT-Brick assembly as shown in
the two figures.

7. On your own, align the center axes of
the lower Peg on the Arm assembly to
the corresponding hole feature on the
NXT-Brick assembly. (The top of the
Beam 9-module part on the Arm
assembly is parallel to the top of the
NXT-Brick.)

8. Apply another Mate constraint to
complete assembling the Arm as
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9. Align the two Pegs on the Head assembly to the bottom of the NXT-Brick
assembly as shown.

10. Complete the assembly by adding another Mate constraint to align the Head
assembly as shown.
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